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Release Notes
The Integrated Circuit Characterization and Analysis Program (IC-CAP) is the industry standard platform for DC and High Frequency measurement and modeling
of semiconductor devices. For general information about IC-CAP, refer to the  EEsof product page at http://www.keysight.com/�nd/eesof-products.  
This document describes new features, functionality, �xed issues and known issues in IC-CAP 2018. It also includes documentation changes and provides
workarounds for defects wherever possible. For more information on known issues in IC-CAP 2018, or to report a new issue, refer to the Keysight EEsof
Knowledge Center at: https://edasupportweb.software.keysight.com/.  
To download IC-CAP 2018, visit the Keysight EEsof Knowledge Center website: http://www.keysight.com/�nd/eesof-iccap-latest-downloads.

To install IC-CAP 2018 in minimal steps, refer to IC-CAP Quick Install and License Setup.

To install licenses for IC-CAP 2018 through IC-CAP 2018 License Tools, refer to IC-CAP Licensing.

What's New
New Features in 2018

Power Electronics Model Generator (PEMG) bundle, which includes IC-CAP Add-on extractions for SiC, IGBT and GaN for Power Electronics. For more
information, refer Power Electronics Model Generator. 

 PEMG is supported only on 64-bit platforms.

IC-CAP 2018 includes new PEL VISA functions available for use in IC-CAP Macros and Transforms to connect with GPIB interfaces and measurement
instruments for communication using the "Virtual Instrument Software Architecture" (VISA) standard API. For more information, refer to VISA
Programming.
The python library PyVISA (version 1.8) has been included as built-in python packages available in IC-CAP 2018. The PyVISA library can be used from within
IC-CAP Python Macros and Transforms programs to connect with instruments and to communicate with instruments programmatically. For more
information refer to VISA Programming.
A new IC-CAP example �le has been added to demonstrate the new PEL VISA functions and PyVISA function capabilities: Please �nd new example �le
located in the following installation directory:  <ICCAP_ROOT>/examples/visa/programming_visa.mdl. For more information, refer to VISA Programming.
New built-in IC-CAP PEL INSTR functions: INSTR_open, INSTR_write, INSTR_read, INSTR_close, INSTR_...  have been added to IC-CAP 2018 for VISA based
programmable direct TCPIP, USB, and GPIB instrument connections and instrument communication from within PEL IC-CAP Macros and Transforms.
These functions complement the current existing PEL HPIB functions which work with GPIB interface connections, as well as direct TCPIP, USB, and GPIB
instrument connections. For more information, refer to INSTR Functions.
Data Viewer provides an intuitive interface for customers who use full-featured IC-CAP WaferPro, WaferPro Express, or MBP. It allows the users of IC-CAP
WaferPro to read a large volume of MDM �les by specifying Lot, Wafer, and Die, and to view the measured data in plots as per the selection.
For DynaFET, the Extrapolation feature is integrated. With this function, users can generate extrapolated data for model extraction. 

Enhancements in 2018

The built-in IC-CAP PEL HPIB functions: HPIB_open, HPIB_write, HPIB_read, HPIB_close, HPIB_... have been updated in IC-CAP 2018 to support VISA TCPIP,
USB and GPIB directly connected instruments, to extend the current GPIB interface connection capabilities for programmable instrument communication
from within PEL IC-CAP Macros and Transforms. For more information, refer to HPIB Functions.
The IC-CAP Hardware Setup Window now supports adding VISA connections to TCPIP, USB, and GPIB directly connected instruments, to extend the
current existing GPIB interface connections that IC-CAP already supports. For more information, refer to GPIB Interface and Instrument Connection
Names.
The IC-CAP Hardware Setup Window's speed to rebuild the list of active instruments per connected GPIB interface has been improved. The number of
SCPI commands sent to each interface address to determine the IC-CAP instrument driver to associate with that GPIB interface address has been reduced,
signi�cantly improving the speed to identify the instruments connected per address of a given GPIB interface.
The List GUI Item has a new special option named "Double Click Behavior", refer to Creating Graphic User Interfaces. The new List GUI Item option
"Double Click Behavior" controls the double click behavior of the list. The values for Double Click Behavior are <None Speci�ed>, Double Click
Classic, Double Click Simpli�ed.  (TFS Issue 98606)

Double Click Simpli�ed mode sets double click to not send a selection callback when an already selected item is double clicked, and will not send
a selection callback and not de-select an already selected item when Selection Policy is Single Item Select or Select Multiple Items.
Double Click Classic mode sets double click to send a selection callback if an already selected item is double clicked, and will send a selection
callback and de-select an already selected item when Selection Policy is Single Item Select or Select Multiple Items.
Default behavior if <None Speci�ed> is selected is Double Click Classic mode.

In PEL and Python, 3 new built-in IC-CAP functions are included for getting the X, Y, or Y2 datasets for a given Plot's de�ned traces. The functions are
get_plot_data_x(), get_plot_data_y() and get_plot_data_y2(). (TFS Issue 122727)

The new function details are listed below:

get_plot_data_x Returns the given Plot de�nition's X dataset used for the Plot's X data trace, the Plot's Y2 data trace, or a particular Plot's Y data
trace number.

get_plot_data_y Returns the given Plot de�nitions Y dataset for the given particular Plot Y data trace number.

get_plot_data_y2 Returns the given Plot de�nition's Y2 dataset for the Plot's Y2 data trace if the Plot is of type XY plot.- 

For  new built-in IC-CAP functions have be added, the new functions are listed below:

set_return_value Returns a value to the transform dataset

set_return_array Returns a list to the transform dataset

set_return_matrix_array Returns a python matrix to the transform dataset.

Updated the built-in IC-CAP PNA and PNA-X drivers connection list to automatically support the latest B model versions of the most popular PNA models
available. For more information, refer Keysight PNA Series Vector Network Analyzer and Keysight PNA-X Series Vector Network Analyzer. (TFS Issue
145885)
Updated the  Vector Star instrument driver to support 2-Port S-Parameter measurements with a multiport  instrument, via specifying the
ports of interest in the IC-CAP Instrument options. (TFS 152043)
The following new plot functions are provided in this release: ndata, tdata, udata, and plot_vs.
For DynaFET, the following updates have been made:
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Supports the new format for NVNA data �le: The order of AM_2_1 and AP_2_1; and the AP_2_1 unit are updated.

VAR MeasSeg(real) = 0 VAR VDC_1(real) = -1.86 VAR VDC_2(real) = 16 VAR fund_1(real) = 100000000 VAR Src1Power(real) = 0.001 VAR AP_2_1(real)
= -165.000000 VAR AM_2_1(real) = 0.001

Issues Fixed in 2018

Fixed the copy, rename, and delete methods for IC-CAP Python API IC-CAP objects of type Input, Output, Setup, Dut, Model, Macro, Transform, or Plot, to
only copy, rename, and/or delete the IC-CAP objects of the same type as the IC-CAP object in python to perform the operation upon. Therefore if a plot
and a transform or input have the same name, a delete on a plot object of that name will delete the plot object and not the input or transform that is
found �rst in an IC-CAP named object search. (TFS Issue 133835)
Fixed crash in Variable table when an ICCAP_ARRAY[<dim>] is entered for a value in an unnamed variable row. Now the IC-CAP_ARRAY[<dim>] value can
be added to an unnamed variable row in the variable tables without a crash, but the dimension of the ICCAP Array will not be initialized until the variable
row is given a name. (TFS Issue 71346)
Fixed IC-CAP crash with Custom GUI Table widgets found during IC-CAP Exit or during Deletion of IC-CAP variables when an IC-CAP GUI Table widget has a
property set to for Variable Value tracking. (TFS Issue 129088, 141842, 137633) 
Fixed issue with IC-CAP Python API function get_child_objects() not working properly and throws an Exception for some IC-CAP Inputs with sweep type of
'LIN_DOUBLE', 'LOG_DOUBLE', 'EXP', 'PULSE', 'PWL', 'SFFM', 'SIN', 'TLYSNC', 'TDR', or 'SEG'. (TFS Issue 138048)
Updated IC-CAP Python API function "set_par()" to now accept a string value, for use in setting a parameter value to the name of an IC-CAP variable. (TFS
Issue 131757)
Fixed IC-CAP crash when deleting a Macro that is currently being edited. (TFS Issue 123302, 145497)
Fixed writing S2P touchstone and S2PMDIF �les by WaferPro and IC-CAP to use the same double precision that MDM �les are written with. The S2P
touchstone and S2PMDIF formats were only being written out in the past with a �xed default precision of 6 for double precision values. (TFS Issue 151396)
Fixed some potential crashes in the IC-CAP Optimization and Parameter group features within IC-CAP. (TFS Issue 137633)
Fixed PSPICE netlisting .PARAM error with LIST input sweeps when LIST input sweeps were second order or greater in sweep order. (TFS Issue 150032,
135210)
Fixed IC-CAP crash with Multiplot referring to itself. (TFS Issue 134416, 79364)
Fixed issue with Plot displaying the wrong Y and Y2 trace colors, line types, and symbol marker types when setting new Trace Options in the Plot Options
dialog for the Y2 Data trace and for Y Data traces above number 8 in XY Plot types. (TFS Issue 128864)
Fixed issue with reading in Plot trace plot options information from IC-CAP Model, DUT, Setup, or Plot �les where the Plot is more than 8 Y data traces.
(TFS Issue 128865)
Fixed issue with the IC-CAP Python API Output class where the "Admittance/Impedance" Output's mode character was incorrectly speci�ed as 'Z' versus its
correct output Mode character of 'X'. (TFS Issue 152492)
Fixed issue with Plot trace plot options y data trace numbers being incorrect if one reduces the Plot De�nition's # of Y traces below 8 Y data  traces and
then increases it again. (TFS Issue 133525)
Fixed IC-CAP crash when Loading a Plot Options �le which contains less Y data trace options information than the current number of Y data trace options
currently loaded in the Plot Options dialog and the Ok button is then pressed. (TFS Issue 154041)
Fixed issue with Plot displaying the wrong Y2 data trace color, line type, and symbol marker type de�ned for the Y2 Data trace in the Trace Options tab
of the Plot Options dialog when the plot de�nition has less than 8 Y data traces. (TFS Issue 138588)
Rebuild Instrument List in the Hardware Setup window will preserve all open setups' instrument options instead of clearing and resetting the open
setups' instrument options. This is con�gurable under the Hardware Setup Window's Tools → Settings → Preserve Instrument Options During
Instrument Rebuild menu. (TFS Issue 106918)
Fixed IC-CAP WaferPro crash when restarting a new WaferPro session after exiting WaferPro and choosing Cancel on the save WaferPro project Save
dialog. (TFS Issue 155887)
New option for B1505: BYPASS_INPUT_RESOL_CHECK option was introduced for HCSMU (B1512, including Dual HCSMU), MCSMU (B1514), UHC (Ultra High
Current Unit), UHV (Ultra High Voltage Unit), HVMCU (High Voltage MCU), as well as HVSMU (B1513), to bypass the input resolution check.
MCSMU support was enabled for B1500A.
Enabled force and measure V for B1500 with Use User Sweep = No.

Issues Fixed for Licensing in 2018

On windows, a possible Administrator privilege issue preventing the automatic restarting of the FlexFNP license server program, lmgrd after the PC
comes out of the hibernation mode has been �xed. The License Setup Wizard will automatically restart the server without any user intervention.

Known Issues

Problem Solution

IC-CAP runs child processes named cygpath.exe and sh.exe.
On , 8 and 10, these processes appear as minimized
console windows (similar to cmd prompt) in your task bar. If you
restore these windows, a black window may appear.

It is recommended to ignore these windows and keep them minimized as they are
required for proper functioning of IC-CAP. If you close these windows, IC-CAP will
open these windows again at a later time.

On Linux, the Save Image option may fail for JPG and some other
graphics �le formats.

The solution is to replace the convert found under $ICCAP_ROOT/ /bin
folder with the convert from /usr/bin folder. An example command is cp
/usr/bin/convert $ICCAP_ROOT/ImageMagick/bin/convert.

Optimizer check buttons column often appear too wide when
viewing Optimizer Parameter Tables saved from earlier versions of
IC-CAP.

NA

When passing variable table values to another transform/macro
using GET_INT, it is better to pass val (varname) rather than
varname as there is a problem properly dereferencing the
variable. It is dereferenced in the context of the get_int() call, not
the iccap_func call. This problem will be repaired in a future
release.

NA

If you use DYNAMIC_MULTIPLOT_MODE in multiplots, autoscale
behavior may be a�ected. Normally all plots within a multiplot
have a separate scaling setting from one multiplot to another or
when viewed as a single plot. This allows you to place the same
plot twice in a multiplot with di�erent manual scaling settings or
have the same plot in 2 multiplots, one autoscaled and the other
manual scaled or any such combination. The
DYNAMIC_MULTIPLOT_MODE causes the scaling presented in a
multiplot to be identical to that displayed in the single plot. If you
change the scaling in the multiplot, it will change the default
scaling also for when viewing the single plot. But there is currently
a problem when changing the scaling properties from the
multiplot. The scaling saved to the single plot becomes incorrect
leading to unpredictable results.

Open the single plot and set the scaling as desired, once this is done, the plots will
open as expected in the multiplot.

Windows 7

ImageMagick



Problem Solution

It was found that opening/closing thousands of plots in a session
may cause the IC-CAP process to grow and ultimately crash.

NA

When using WaferPro, selecting "Display Plot During Execution" to
"Yes" may result in a blank plot window when trying to resize the
plot. This will not a�ect the data collection.

Set the value to "No" and view the results by clicking on the device measurement lines
in the log window.

When viewing plots on multiplot, sometimes symbol size is
inconsistent. This may a�ect the quality of the plot for
documentation/publishing purposes.

NA

When displaying to a remote display from Linux (Speci�cally
 Xwin or Exceed onDemand) you may observe substantial

performance problems on the Model window when selecting
setups.

Setting environment variable QT_GRAPHICSSYSTEM=native before launching IC-
CAP should improve the performance. Some systems may see further improvement
by setting EESOF_REMOTE_DISPLAY_DEFAULT_OVERRIDE=1.

You may observe performance issue during WaferPro Test Plan
Run on  platform, as compared to IC-CAP 2013.01 release.

If IC-CAP 2013.01 is installed on your machine,
set ICCAP_CPP_PATH=c:\agilent\iccap_2013_01\bin\icpp in the
$HOME\ICCONFIG �le.

Invoking IC-CAP 2014.04 or 2013.01 on windows after installing the
new 2015.05 licensing module that comes with IC-CAP
2016.01 may repeatedly ask for bundle usage and not remember
the selection.

Either answer the question each time you invoke older versions, or look for 
 ICCAP_PRODSEL_AUTOSTART and ICCAP_PRODSEL_PREVIOUS that de�ne your

default bundle for Licensing 2015.05 under
HKEY_CURRENT_USER\Software\Agilent\EEsof License Con�guration and under
HKEY_CURRENT_USER\Software\ \EEsof License Con�guration.  Copy the
values of these two keys to new keys in the same location named
ICCAP_PRODSEL_AUTOSTART and ICCAP_PRODSEL_PREVIOUS.

Under certain conditions, you may observe the following message,
while opening a plot. However, the plot will appear correctly
despite the message.

SB: VDC of size zero is not allowed

Ignore the messages.

The DynaFET model created using ICCAP 2018 is not compatible
with the older versions of ICCAP.

NA

The DynaFET package is not supported for the Linux 32-bit
platforms.

NA

The following IC-CAP Modeling Extraction Packages are not
supported for simulation with the ADS simulator (hpeesofsim) for
the Linux 32-bit platforms. (TFS 150839)

BSIMSOI: Example Model �le: $ICCAP_ROOT
\examples\model_�les\mosfet\bsimsoi4\BSIMSOI4_Extract.mdl
HiSIM_HV: Example Model �le: $ICCAP_ROOT
\examples\model_�les\mosfet\hisim_hv\HiSIM_HV_Extract.mdl
PSP: Example Model �le: $ICCAP_ROOT
\examples\model_�les\mosfet\psp\PSP_Extract.mdl
HiSIM2:  Example Model �le: $ICCAP_ROOT
\examples\model_�les\mosfet\hisim2\HiSIM2_Extract.mdl

NA

The 64-bit versions of hpeesofsim and IC-CAP work �ne. 

For 32-bit, the hspice 2010.03(32-bit) simulator and spectre MMSIM_15.10.727 work
�ne.

plot_vs() function does not support range plots.
plot_vs() plots currently cannot be used for Y2 Data.
“View Data” display for plots does not properly support plots
where multiple traces rely on di�ering X data.  This can
happen when using plot_vs() or USE_PLOT_LOOKUP=TRUE.
When using plot_vs() functions or USE_PLOT_LOOKUP=TRUE
features to construct plots with di�ering numbers of curves or
di�ering X names, plot decoration such as X label and legend
lines default to the decoration of the �rst trace in the plot
regardless of selected points. 

NA

The IC-CAP PEL system variable ICCAP_MAXIMUM_CALL_CHAIN is
not working. (TFS 123432)

The maximum number of PEL Transforms or Macros that can be
called (via iccap_func()) without returning will not be limited by the
ICCAP_MAXIMUM_CALL_CHAIN variable. 

Any in�nitely recursive Macro or Transform function calls can
continue to cause IC-CAP to consume all available system
memory and potentially freeze your system and crash IC-CAP
when setting the ICCAP_MAXIMUM_CALL_CHAIN variable. 

NA

The last o�cial 32-bit Linux version for ADS is ADS 2011.01.
However, this version does not work with IC-CAP 2018 due to
licensing.

Use ADS 2013.06, and comment the following lines in $HPEESOF_DIR/bin/sim-
bootscript.sh:
    #if  [ "$MACH_UNAME" != "x86_64" ] ; then

#echo "\nThis EEsof product is not supported on 32-bit versions of Linux
operating systems.\n" 

#exit 1

    #�
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Problem Solution

IC-CAP may fail to start on /10 machines that have
 488.2 IO libraries version 2.8 or older

installed. 

IC-CAP 2018 has a new dependency on the 3rd party IO libraries
shared library named visa64.dll that is installed with Keysight IO
Libraries and/or National Instrument IO Libraries. 

The VISA API version of visa64.dll that is installed with National
Instruments IO libraries 488.2 version 2.8 and older are not
compatible with the VISA API that IC-CAP 2018 uses.  (TFS Issue
154807)

There are 2 recommended ways to resolve this issue:

1. Upgrade your installed  488.2 IO libraries version from 2.8 or
older to a newer version such as versions:

NI 488.2 IO libraries version 3.1.2
NI 488.2 IO libraries version 14.0
NI 488.2 IO libraries version 15.0
NI 488.2 IO libraries version 16.0
NI 488.2 IO libraries version 17.0 *(Recommended version: This is the
 newest/latest version available.)

Or, If you require to still use NI 488.2 IO libraries version 2.8 or older on your system

2. Copy the IC-CAP supplied stub visa64.dll �le from

   %ICCAP_ROOT%/lib/win32_64/visa64.dll

    to

    %ICCAP_ROOT%/bin/visa64.dll

    to workaround the IC-CAP 2018 will not start issue.

On Linux platforms in , , or  window managers, IC-
CAP 2018 may render some IC-CAP widgets to appear larger in
height than in IC-CAP 2016. (TFS Issue 152953)

 

In IC-CAP 2018 set the following variable on Linux:
ICCAP_LEGACY_WIDGET_SIZING=TRUE

to have the IC-CAP 2018 windows/widgets draw in vertical height similarly to how they
did in IC-CAP 2016.

A side e�ect of using this variable is that the default FONT may
appear to be 1 pixel size smaller in height/width with this
con�guration �le setting. You can set this variable in the
environment before IC-CAP startup or by setting it in the
$HOME/hpeesof/con�g/iccap.cfg �le before IC-CAP startup.

--

Another possible workaround is to set the monitor or Virtual Desktop environment (if
using VNC) to have a  (Dots Per Inch) setting that is 88-96% of the current set 
value used in IC-CAP 2016.

Occasionally, external simulators may hang or crash when invoked
by IC-CAP. Speci�cally, the ADS 2016.01 simulator has been found
to stop working with the PE Verilog-A  models. 

In general, IC-CAP will continue to function once the hung/crashed simulator process
has been stopped. This may require using task manager to kill the hung process, or
dismissing all dialogs alerting you to the crash. In the case of PE Verilog-A, it is
recommended to use ADS 2017.

In Data Viewer, if a test plan is rerun after changing the Die in
project with the same measurement condition (just changing some
bias for same condition).
If you use the [Dir ] option to see data for all Dies, it shows
incorrect data. 

For the bias, which are same for both runs, it shows zero data when we plot for all
Die’s from both run or it will simply plot data from the �rst run for which the bias
condition is di�erent.
A possible workaround is to use di�erent MeasCond / MeasGroup name. 

If you have set 'step plots' in the model �le saved in IC-CAP 2018, it
may not be read �ne in IC-CAP 2016.

NA

Once you perform math on a dataset with name/unit/text
associated with it, the name/unit/text will be forgotten.

If you want to attach name/unit/text data, it should be done after all the math
operations are applied.

For example:

ndata(x*y*z,”my_x_y_x’)  ! name “my_x_y_z” will be attached to the product of x,y, and
z

rather than

ndata(x,”x”)*ndata(y,”y’)*ndata(z,”z’)  ! names will be forgotten

While using   7, the windows that pops up on clicking few
items can get tied to the windows behind it.

Open a terminal and type 'gnome-tweak-tool' and turn o� 'Attached Model Dialogs'
setting in the 'Windows' section:

In PEMG, the Save option becomes inactive if you try to save a
project with a �le name that includes a space.

A �le name with a space is not supported. You can use the Save As option to the save
the project. 

In PEMG, the Maximize button may not behave as desired
on Exceed onDemand (EOD) and Exceed TurboX (ETX)  display.

NA 

Crash dump is displayed if you close IC-CAP after using Data
Viewer on Exceed onDemand display.

NA

On , while invoking IC-CAP, an error message is
sometimes displayed in the Status window.

A possible workaround is to install the latest version of . 

Windows 7
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Problem Solution

IC-CAP may crash sometimes while using Admos packages. NA 

On Linux, IC-CAP crashes while running the NeuroFet.  NA 

IC-CAP crashes if the netlist circuit �le includes a line with 20000
characters. 

NA 

Spectre results in negative capacitances for S-parameter
simulation. 

NA 

HB 2 tone simulation not reading full data into IC-CAP. NA 

While using the Advanced Module options in PEMG, sometimes if
you add a DUT/Setup in the Measure Module, and then run the
associated step, the DUT/Setup list in the Extract Module is not
automatically updated.  

The workaround to view the updated DUT/Setup is to use the Load Data option on the
Measured Data page. 

On Linux, unable to delete the PEMG folder under the IC-CAP
installation directory.

The workaround is to use the chmod 777 -R command on the
$ICCAP_ROOT/ModelGenerator directory before trying to delete. 

On Windows 7 32-bit, the  simulation fails. The workaround is to keep the simulation debugger open while performing the
simulation.

In Data Viewer, an error is displayed if you open the
wafermap_sim.mdmprj  example from the File > Examples menu.

The workaround is to access this example from the Data Viewer home page. 

If you are using IC-CAP 32-bit version on a  64-bit machine,
the  help window does not open using the Help > Topics and
Index menu. 

The workaround is to install readline. , sqlite.i686, and the other required libraries
as listed in the Installation section known issues.  

Documentation

On Windows, Printing directly from Qt Help generates non-readable output. Workaround: Use PDF version of the document for printing purpose.
In IC-CAP help when you open a page using the "Open a link in new tab" option the help does not opens a page in di�erent tab by default. You need to set
the preferences to open any link in a new tab. To set the preferences:

1. From the IC-CAP Help, Click Edit > Preferences. The Preferences Dialog box is displayed.
2. Select the Options tab.
3. Under Appearance, select the Show tabs for each individual page option.

This is one time setting for a particular release of a product.
Unable to open online help, any external link, or Embedded Survey link in Linux on  browser. Workaround: Use  version 39
or above or keep the Firefox window open and then try to open online help.
IC-CAP online help is not supported on the . Workaround: Use  or Firefox version 39 or above to view ADS
documentation.
If the IC-CAP help does not show any content, throws an error, or does not display any search results. Workaround: Close the help and delete the
contents of the following directory:

On Windows 7: C:\Users\<Windows_Login_ID>\AppData\Local\Keysight\Help

On Linux: $HOME/.local/share/Keysight/Help

IC-CAP Qt search does not support [] or {} or any other text using these combinations. 

Simulation

Segment Sweep with Noise analysis is not creating the correct netlist for the ADS simulator.
Simulating to ADS 2014.01 or later requires IC-CAP 2014.04 or newer version.  Older versions of IC-CAP cannot work with ADS 2014.01 and
beyond. 
When performing ADS simulations with Verilog-A references using ADS 2014 and IC-CAP 2014.04 on Linux, ensure to set the environment
variable, ADS_LICENSE_FILE, to reference your IC-CAP license �le before launching IC-CAP.  Without this setting, ADS will be unable to
properly compile *.va �les for simulation.
ADS simulations to IC-CAP 2016.01 are now performed in the $HOME/hpeesof/iccap_ads/data directory and not in the current working directory.
Although it does not a�ect most simulations, if you direct ADS to load a �le relative to the current working directory with the assumption that
current working directory will be the same as IC-CAP, this will no longer work for simulations to ADS 2016.01.  Please modify such netlists to refer
to the full path of the �le that ADS must access. 

Installation

Problem Solution

On Windows systems, if you have installed a pre-release version of IC-CAP and then try to install the
current version or a newer version of the IC-CAP release, you can get the warning stating 'Previous
Version Detected' even though you have uninstalled the current version properly.

To get past the 'Previous Version Detected'
message while installing, you need to delete
the .com.zerog.registry �le.

On 64 bit systems the �le is at C:\Program
Files (x86)\Zero G Registry\
.com.zerog.registry.
On 32-bit systems, the path to this �le is
C:\Program Files\Zero G Registry\
.com.zerog.registry. (The directory Zero G
Registry is a hidden folder so you need to
turn on Show hidden �les…. On Windows 7,
you can get to this setting under Control
Panel\Appearance and
Personalization\Show hidden �les and
folder.)

IC-CAP ships with an installation of  ‘convert’ for the Save Image feature in plots. Without a
working ‘convert’ call, the Save Image option can only save JPG, BMP, PNG, PPM, XBM, and XPM formats.
The version of convert shipped with IC-CAP does not work on  version 5, though most default
installations of  version 5 will have a working ImageMagick tool in /usr/bin/convert folder. IC-CAP
tests for a workable ‘convert’ program during launch. Initially at $MAGICK_HOME/bin/convert, then within
IC-CAP installation, and �nally within the path. A warning about the limited save options are issued at
launch if no working version of ‘convert’ is found.

To avoid this warning, you can install a current
version of ImageMagick on your system or set
the MAGICK_HOME environment variable to a
working installation.
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Problem Solution

IC-CAP 2018 crashes while launching the 32-bit installer on some 64-bit machine. 
A possible workaround is to install the following
libraries:

dbus-libs.
libstdc++.i686
zlib.i686
libXrender.i686
libICE.i686
libSM.i686
libXext.i686
libX11.i686
xcb-util.i686
libXi.i686
compat-libxcb.i686
libxcb-devel.i686
xcb-util-devel.i686
xcb-util-image.i686
xcb-util-image-devel.i686
xcb-util-renderutil.i686 
xcb-util-renderutil-devel.i686
xcb-util-wm.i686
xcb-util-wm-devel.i686
libX11-devel.i686
libICE-devel.i686
fontcon�g.i686

 

On RHEL 7.1 Workstation.x86_64, install the
following libraries:

compat-libcap1-1.10-7.el7.i686
libXrender-0.9.8-2.1.el7.i686
dbus-libs-1.6.12-11.el7.i686
libstdc++-4.8.3-9.el7.i686
fontcon�g-2.10.95-7.el7.i686
libxcb-devel-1.9-5.el7.i686
libICE-1.0.8-7.el7.i686
readline-6.2-9.el7.i686
libICE-devel-1.0.8-7.el7.i686
sqlite-3.7.17-4.el7.i686
libSM-1.2.1-7.el7.i686 
xcb-util-0.3.9-4.el7.i686
libX11-1.6.0-2.1.el7.i686
xcb-util-image-0.3.9-4.el7.i686
libX11-devel-1.6.0-2.1.el7.i686
xcb-util-wm-0.3.9-5.el7.i686
libXext-1.3.2-2.1.el7.i686
zlib-1.2.7-13.el7.i686
libXi-1.7.2-2.1.el7.i686

If McAfee antivirus is running, it may pause the installation. On disabling the Security �rewall option in
McAfee antivirus settings, the installation works
�ne. After the installation is complete, enable
the Security �rewall option in the McAfee
antivirus settings. 

 

Licensing

Problem Solution

New license server software packaged in the EEsof EDA License Tools version
2014.01 does not work on SuSE 10 platform.

Use SuSE 11 or RHEL 5 or 6 instead as your Linux license server machine.

License server may stop recognizing Flex-10 dongle on some systems within a
few hours after starting.

If you experience this problem, it can be remedied by installing the latest
WibuKey drivers from Wibu Systems.

Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a
machine.

Before installing a Flex-10 driver for the �rst time, unplug the Flex-9
dongle.

There is a known  FNP issue, whereby mixing node-locked codewords
and �oating codewords in one license �le can result in:  
a) Remote simulations not working or  
b) A second local simulation not working in case the license is node-locked and
also has incorrect version.

It is strongly recommended that you do not mix node-locked codewords
and �oating codewords in one license �le nor in any con�guration that
ends up with node-locked codewords and �oating codewords both
available on the same server. In other words, put the node-locked license
and the �oating license on di�erent servers, and point to the respective
one based on what you need to run. 
Additionally, we also recommend you to remove expired codewords, to
separate out the new and the old versions of codewords into di�erent
�les and di�erent servers, and to point to the respective one based on
what you need to run.

On the Linux platform, NAMEofPRODUCT_LICENSE_FILE needs to be correctly
speci�ed before starting SHORT_PRODUCT_NAME. Without that being set
correctly, SHORT_PRODUCT_NAME would not start.

Set NAMEofPRODUCT_LICENSE_FILE as instructed.

i686

Flexera

https://www.wibu.com/us/downloads-user-software.html


Problem Solution

Not specifying the TCP/IP port for the license server during license setup may
lead to unexpected behavior and/or license checkout failure on the Windows
platform.

We strongly recommend you to always explicitly specify the TCP/IP port
associated with each license server.

A node-locked and �oating bundle operating on Linux cannot be shared
between products using EDA License Tools version 2014.01 and 11.9.0.0 or
earlier when run at the same time.

NA

The "Check-in failed" message occurs in the license activity log occasionally can
be ignored; the license mentioned in this message is actually properly
returned.

NA

License Setup Wizard does not remove any previous user-con�gured FLEX
Windows License Service installed using FlexNet's lmtools.

You must remove the previous user-con�gured  License Service
via lmtools.

Run the lmtools.exe from C:\Program
Files\Agilent\EEsof_License_Tools\bin to invoke the
lmtools utility. The lmtools utility window is displayed.
In the Service/License File tab, check the Con�guration using
Services option. All user-con�gured FLEX Windows License Services
will be listed.
Select the service you wish to remove.
Select the Con�g Services tab and click the Remove Service button
to remove the service. 
To ensure that the license service or lmgrd is running, click View Log.
A log window appears that con�rms whether agileesofd and lmgrd
are up and running.

While running multiple versions of prior SHORT_PRODUCT_NAME releases
together, set NAMEofPRODUCT_MAXIMUM_BUNDLE_USAGE=ON in your
environment so that all of them will use the same method to check out
licenses. Otherwise, you might receive an error message, "Licensed number of
users already reached".

NA

On some Windows 7 machines, when more than one de�nition of an 
 exists (duplicates), license checkouts may appear to hang up.

Disable the duplicate network card de�nitions in your network settings:
Control Panel > Network and Internet > Network Connections. This
issue has been acknowledged by  and they have created a bug
report (SIOC-000103097).

If a license server is con�gured with two license versions, that is, version 2.8
and 2.9 node-locked license �les, the license server may crash.

You should combine the two license �les into one �le, instead of using
them separately.

For LSF style distributed simulations, in case of windows, ensure that the PATH
points to the $HPEESOF_DIR/EEsof_License_Tools/${architecture} directory
that corresponds to the EEsof release being used. This needs to be done in
order to ensure that the proper version of the Flexera utilities (like lmutil) gets
picked up in the path before any older in-compatible versions (that may also
be installed on a users’ system.)

 

License Setup Wizard (aglmwizard.exe), which is used to set up and record
the license path would not work if you already have an environment variable
set for NAMEofPRODUCT_LICENSE_FILE.

You can use NAMEofPRODUCT_LICENSE_FILE variable to point to license
�le or refer to  Licensing (For Administrators).

The License Setup Wizard will exit or not properly con�gure a license server, if
the server has all of its licenses currently in use.

Wait for a license on the server to become available as you normally
would before launching the product.

If SHORT_PRODUCT_NAME does not start after you reboot your 64-bit
Windows computer, and a license denial message is displayed, then it might
be caused by a spurious registry entry.

Check to see if registry entry \SOFTWARE\FLEXlm
License Manager\EEsof EDA License Server exists; if it does, remove it and
restart SHORT_PRODUCT_NAME.

Unable to set license in case unicode characters are used either in path or
license �le name because the Flex License Service does not support these
characters.

NA

The Product Selector tool will be unable to display the license server status
properly when connected to older license server.

Upgrade your license server to the latest version.

When the same user is running similar simulations from multiple sessions of
IC-CAP on the same computer and display—that is, the same User-Display-
Host— and if simulations are rerun an extra license may be pulled.

Click Stop from the Status window of all the IC-CAP sessions to release all
the simulator licenses, then rerun the simulations.

Product selector opens every time we invoke IC-CAP 2014.04 even when we
auto-start by selecting a particular product license. 

Set the environment variables, IC-CAP_PRODSEL_PREVIOUS and
IC-CAP_PRODSEL_AUTOSTART to the same values of what it is
creating ICCAP_PRODSEL_PREVIOUS and
ICCAP_PRODSEL_AUTOSTART resolves the problem.

Licensing Information
IC-CAP  2018 requires:

version 2017.01 of the EEsof EDA licensing software,
a minimum code-word version 2017.01 or above
the licensing server software, lmgrd and agileesofd, to be upgraded to at least the same versions as what are included in EEsof EDA Licensing
software 2017.01.  IC-CAP  2018 will not start if any of these requirements is not met. Refer to the License Codeword Version Compatibility table.

In the EEsof EDA License Tools version 2017.01, licensing vendor daemon ( agileesofd ) is integrated with FlexNet FNP 11.13.1.4 version (Windows) and
FlexNet FNP 11.13.1.3 version (Linux) of FlexNet license manager daemon ( lmgrd ). For the Windows platform,  IC-CAP installer will automatically set up
these two new license server daemons by default for the local node-locked license users; for the Linux platform, you need to follow the Linux/Solaris
Licensing Setup instruction to complete the licensing con�guration process. For more details, refer to Licensing (For Administrators).
A My Support ID utility is added to the License manager tool to allow a user to retrieve his/her Support ID required to contact Keysight EEsof Tech
Support.

Enhancements and Improvements

For simpli�ed and robust licensing, PJC (Per Job Control) licenses are no longer checked out by IC-CAP 2018.
The License Setup Wizard no longer requires Administrator privilege on Windows to setup license �les. Administrator privilege is only required to setup
the windows service that will automatically start the license server upon system restart rather than on EEsof application startup.
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HKEY_LOCAL_MACHINE

http://edadocs.software.keysight.com/display/iccap2018/Licensing%20(For%20Administrators)
http://edadocs.software.keysight.com/pages/viewpage.action?pageId=471694650
http://edadocs.software.keysight.com/display/iccapss/Setting+Up+Licenses+on+Linux+and+Solaris
http://edadocs.software.keysight.com/pages/viewpage.action?pageId=31854459
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